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Getting Started with CodeXL

Introduction
AMD CodeXL™ is a tool suite with a unified user interface that lets you harness
the benefits of AMD CPUs, GPUs, and APUs. It has powerful capabilities for
APU/GPU debugging, CPU and GPU profiling, and static OpenCL™ kernel analysis.
These features let you find bugs, optimize application performance, and easily
access heterogeneous computing. AMD CodeXL is available as a stand-alone
application for Windows® and Linux®, as well as a Microsoft® Visual Studio®
extension for Windows.
Getting the most out of the AMD CodeXL tool suite requires a relatively recent
AMD APU, a recent version of Catalyst, and the OpenCL APP SDK.
This document describes how to
•
•
•

get started using CodeXL
find information about known CodeXL issues
contact AMD for support

Latest Version of This Document
•

For the latest and greatest version of the documentation, go to the CodeXL
Website.

Prerequisites
Operating Systems
•
•
•

Microsoft Windows 7 64-bit
Microsoft Windows 8.1 64-bit
Linux 64-bit (Red Hat, Ubuntu)

For detailed system requirements see the CodeXL Release Notes in the CodeXL
installation folder or on the Documentation section of the CodeXL web page.
CodeXL Visual Studio Extension
•
•
•

[Optional] Microsoft Visual Studio 2010 (Standard/Professional/Team
System Edition)
[Optional] Microsoft Visual Studio 2012
(Professional/Premium/Ultimate Edition)
[Optional] Microsoft Visual Studio 2013
(Professional/Premium/Ultimate Edition)

Profiling OpenCL™ Applications
•
•

[GPU device] AMD Catalyst driver with OpenCL™ GPU support
[GPU device] AMD Radeon™ HD 5000 series or newer
3
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•

AMD APP SDK (requirements)

For detailed system requirements see the CodeXL Release Notes in the CodeXL
installation folder or on the Documentation section of the CodeXL web page.

Download and Install CodeXL
Installation is system-specific (Windows or Linux); but once installed and
started, the CodeXL operation is system-independent.
Download the AMD CodeXL installation package from
http://developer.amd.com/tools-and-sdks/opencl-zone/codexl/#one.
For Windows
1. Download the .exe file AMD_CodeXL_Win*.exe for Windows (32-bit or
64-bit).
2. When the download completes, double-click the .exe file to install
CodeXL.
The installer guides you through the installation process.
The CodeXL Visual Studio 2010 and 2012 extensions are part of the
installer package and are installed by default.
3. Choose “Custom” installation, and de-select the Visual Studio extensions if
you do not want to install them.
For Red Hat/CentOS/Fedora Linux
1. Download the 64-bit Linux RPM package AMD_CodeXL_Linux*.rpm.
2. Install the RPM package directly:
$ sudo rpm -Uvh AMD_CodeXL_Linux*.rpm
3. On RHEL 7 based distributions, the CodeXL Teapot sample application
requires that gtkglext-libs-1.2.0 (or higher) package be installed. In
addition, you may need to obtain the pango-compat package which is
available from EPEL repository. Both modules are required for the Teapot
sample application only, and are not mandatory for CodeXL operation.
For Ubuntu and other Debian based Linux distributions
Either install the tar archive (1.), or install the .deb package (2).
1. Download the 64-bit Linux tar package AMD_CodeXL_Linux*.tar.gz.
$ tar –xvzf AMD_CodeXL_Linux*.tar.gz
or
2. Download the 64-bit Linux Debian package amdcodexl-*.deb.
$ sudo dpkg -i amdcodexl_x.x.x-1_amd64.deb
$ sudo apt-get -f install
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Validate Installation
After CodeXL installation, launch the CodeXL standalone application (or Visual
Studio, if you are using the VS CodeXL extension).
For Windows
1. Ensure that:
• The C:\Program Files (C:\Program Files (x86) on 64-bit machines) folder
should have a new sub-folder named “AMD”, which should have a subfolder named “CodeXL” (the full path of the CodeXL folder should be:
C:\Program Files\AMD\CodeXL, or C:\Program Files (x86)\AMD\CodeXL
on 64-bit machines)
• An AMD CodeXL shortcut appears on the desktop.
• The Control Panel shows AMD CodeXL in its list of installed programs.
2. Double-click on the CodeXL desktop shortcut or select CodeXL from the
program menu.
The CodeXL stand-alone application starts.
For Windows using the Visual Studio plugin
1. Launch Microsoft Visual Studio.
The VS GUI should appear.
2. Verify that AMD CodeXL is installed:
Select Help >> About Microsoft Visual Studio from the menu bar.
Check that CodeXL is listed under Installed products. The VS menu bar includes
a CodeXL pull-down menu.

5

© 2014 Advanced Micro Devices, Inc.

Getting Started with CodeXL
For Linux
Do one of the following:
1. Add one of the following to your PATH:
/opt/AMD/CodeXL_X.X-XXXX/ (or wherever you extracted the tar package)
or,
$ PATH=/opt/AMD/CodeXL_X.X-XXXX:$PATH
$ CodeXL

OR
2. Add one of the following to your PATH:
/opt/AMD/CodeXL_X.X-XXXX/

or
$ cd /opt/AMD/CodeXL_X.X-XXXX/
$ ./CodeXL

The CodeXL standalone application starts, and the CodeXL GUI window
appears.
The CodeXL Explorer view displays: No project loaded, as shown in the
following screenshot. Note that screenshots may vary slightly with different
versions of CodeXL.

Installing the VC++ Redistributable Package
If Visual Studio is not installed under C:\Program Files (or C:\Program Files
(x86) on 64-bit machines), follow these steps to enable CodeXL source view
while CPU profiling .NET applications:
•

Download and install Microsoft Visual C++ 2013 Redistributable x86 package
from: http://www.microsoft.com/en-us/download/details.aspx?id=40784.
6
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•

Register msdia100.dll as a COM component.
 Open a command shell window.
 On 32-bit Windows systems, enter the following command:
regsvr32.exe “c:\Program Files\Common Files\microsoft
shared\VC\msdia100.dll”.

On 64-bit Windows systems, enter the following command:
regsvr32.exe “c:\Program Files (x86)\Common Files\microsoft
shared\VC\msdia100.dll”

CodeXL Help
To bring up a CodeXL Help window:
1. Click on the AMD CodeXL User Guide link on the CodeXL startup Home
Page.
OR
2. Select Help >> View Help from the CodeXL toolbar.

CodeXL Help provides some of the same information provided in this document,
but also includes additional details about CodeXL views and modules.
To bring up the CodeXL Help window for the Visual Studio extension:
1. Select CodeXL >> Help >> View Help from the VS menu.

7
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System information
To display system information:
1. Select Tools >> System Information from the CodeXL toolbar.
The tabs let you select a category of information. The following screenshot
shows OpenCL device information for a GPU device and a CPU device.

To display project settings, the project must be stopped.
To edit the settings of a project:
1. Select File >> Project Settings from the drop-down File menu.

8
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See the CodeXL Help for more details about project settings.

Teapot Sample Project
The CodeXL distribution includes a sample project that displays a smoking
teapot. The project uses OpenCL kernels to solve Navier-Stokes equations. It
shares a 3D texture between OpenCL and OpenGL, copies a density field grid into
the 3D texture, and renders the smoke using OpenGL.
For the Visual Studio extension:
1. Select CodeXL >> OpenTeapot Sample Project from the VS toolbar.
Visual Studio displays the teapot sample project.

9
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Screenshots in the remainder of this document show the standalone version of
CodeXL. The Visual Studio version is similar, but contains a VS window rather
than a CodeXL window.
For Windows or Linux:
1. In the CodeXL home page screen (in the CodeXL menu bar, click on File>Home Page), click the Load the Teapot Sample link.

The CodeXL Explorer view now shows:
AMDTTeaPot | Debug Mode - Not running

The CodeXL window also displays several other views, but since the program is
not running, those views do not display any information.

Debug the Teapot Sample Application
Note: Before debugging the Teapot sample application, you must load it (see the
previous section).
After the teapot sample is loaded, run the debug program:
1. Select Debug >> Start Debugging from the taskbar,
or
2. Click on the green right arrow

taskbar.

The program begins execution, and soon displays a rotating smoking teapot in a
separate window.
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To stop the program:
1. Select Debug >> Stop Debugging from the taskbar,
or
2. Click the black square taskbar Stop button
,
or
3. Click the close button in the upper-right corner of the teapot window.

Basic Debugging
The CodeXL GPU Debugger lets you examine the runtime behavior of your
OpenCL/OpenGL application in detail. You can use the information it provides to
find bugs and to improve application performance. You can debug OpenCL
kernels, inspect variable values across different work items and work groups,
and inspect call stacks, among other things.
This quick start guide presumes you are familiar with the use of a GUI debugger;
so the guide provides only a quick introduction to the basic CodeXL debugging
features.
The following three buttons, at the far left of the CodeXL taskbar, let you select
Debug mode, Profile mode or Analyze mode.

Hovering over a taskbar button displays a pop-up help description.
The following taskbar buttons control program execution during debugging.
11
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These controls are (left to right): start, frame step, draw step, step over, step in,
step out, break, and stop debugging. You can also perform these actions from the
taskbar Debug pull-down menu, or by using function keys.
The following taskbar buttons show, or hide, various views.

These buttons are (left to right): CodeXL Explorer , Properties, Function Calls
History, Debugged Process Events, Call Stack, Locals, Watch, OpenGL™ State
Variables, OpenCL Multi-Watch (1,2,3), Breakpoints, Memory, and Statistics.
You can resize views, drag, and drop views to rearrange them, or move them to a
separate window. The next sections of this guide describe individual CodeXL
views in more detail.

Source Code View
Source Code views display C, C++, or OpenCL code. To display the Source Code
view:
1. Start the teapot program, as described above.
2. Hit the Break button
to interrupt it.
A Source Code view displays the source file where the break occurred, with a
yellow arrow
indicating the current line number. In the following
screenshot, it is line 431 in the amdtteapottoglcanvas.cpp file.
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Breakpoint View
The Breakpoint view shows active breakpoints. Initially, the Breakpoint view
shows no breakpoints:

To add a breakpoint:
1. Double-click “Double-click to add or remove breakpoints…”
A new Breakpoints window appears.

2. Select the API Functions tab to set a breakpoint on an API function, or select the
Kernel Functions tab to set a breakpoint on a kernel function.
When program execution hits a breakpoint, the Source view displays the line
where the breakpoint occurs. A yellow arrow indicates the current location.
A red dot next to the line number indicates a set breakpoint.

13
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Watch and Locals Views
The Watch view shows the values and types of program variables you specify.
The Locals view displays the values and types of local variables in a kernel.

In the image above, the Watch view displays the value of variable dPlaneDist.
The Locals view displays the values of all local variables in the current kernel (in
this case, computeIntersection in tpVolumeSlicing.cl). For a structured
variable, click on the triangle to the left of the variable name to see the name and
value of each member.
A Multi-Watch view lets you compare the values of an OpenCL kernel variable
across work items and work groups.
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Explorer View
The Explorer view displays OpenCL-allocated objects and OpenCL/OpenGL
shared contexts.

1. Click on an object to bring up information about the object in the Properties
view.
For example, clicking on Texture 2 in the view above brings up its properties,
as shown in the next screenshot.

15

© 2014 Advanced Micro Devices, Inc.

Getting Started with CodeXL

2. Click on Vertex Buffer object VBO 1 to display its data, with a variety of
available drop-down menu display and
format options in the righthand panel.

3. Double-click on an object to display an appropriate view.
For example, double-click on Vertex Shader 1 under Shaders to bring up a
Source Code view of its source file tpVertexSharder.glsl. Alternatively,
double-click on Depth buffer to bring up an Image view of the depth buffer.

16
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You can manipulate an Image view with the following image manipulation
buttons on the CodeXL toolbar:

These buttons let you select, zoom in, zoom out, pan, enable R/G/B/alpha
channels, enable grayscale mode, enable color invert mode, original size, best fit,
and rotate CCW/CW. Hovering over the image displays pixel-specific
information (position and color) in the Image Information panel.
Alternatively, select the Data view tab of the depth buffer to display the buffer as
raw spreadsheet data rather than as an image.

Call Stack View
The Call Stack view displays a combined C/C++/OpenCL call stack.
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Function Calls History View
The Function Calls History view displays a log of OpenCL API calls.
1. Click on a function call to display call details in a Properties view.

Debugged Process Events View
The Debugged Process Events view displays process events.

Memory View
The Memory view summarizes memory use.

Statistics View
The Statistics view provides statistical information about the program. Select a
tab to choose among options, such as Function Types:

18
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or Function Calls:

Profile Mode
CodeXL profile mode is a powerful performance analysis tool that supports CPU
and GPU profiling to provide program performance data. CodeXL profiling does
not require modifications to your source code or project. Profiling does not
require recompilation, except for CPU profiling, which requires compilation with
debugging enabled. Profiling lets you find performance hotspots and issues,
determine the top data transfer and kernel execution operations, and identify
problems such as failed API calls and resource leaks. You can use profiling to
improve application performance through proper synchronization, bottleneck
elimination, and load balancing.
CodeXL provides several modes of profiling. These modes let you assess
program performance, use instruction-based sampling (IBS) or time-based
sampling (TBS), or investigate branching, data access, instruction access, or L2
cache access. GPU profiling provides application timeline trace and performance
counter modes.
The following is a quick introduction to CPU and GPU profiling. For further
details, see the CodeXL Help information.

CPU Profiling
To profile a program:
1. Click on the profiling mode taskbar button.
2. Use the Profile drop-down menu to select the profiling mode.
For example, for CPU performance profiling, select Profile >> CPU: Assess
Performance.
3. Click the start button to launch the application for profiling.
19
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4. To stop it, use the stop button any time during profiling. The bottom of the
CodeXL window displays the elapsed clock time.
Profiling is available up to the time the application is closed. For the teapot
example: click on the ‘x’ in the upper right corner of the teapot window.
After profiling is complete and data translation is over, a node in the left session
tree is added for this session.

Overview Tab

The first page shown is the overview page. It shows the Modules and Functions
tables and a brief description of the execution environment and profile detail. If
multiple processes are profiled, then the Process table is shown. Each table
shows the top five hot items.
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Modules Tab

To open the Modules view:
1. Double click or use the “Open Modules” command from the context menu of
the tree’s Modules node.
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Call Graph Tab

To open the Call Graph view:
1. Double click the Call graph node in the Explorer tree, or use the “Open Call
Graph” command from the context menu of the Call Graph node (available
only if Call Stack Sampling was enabled).
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Functions Tab

To open the Functions view:
1. Double-click the Functions node in the Explorer tree, or use the “Open
Functions” command from the context menu of the Function node.
The Functions list can be filtered based on the module to which they belong.
To do this, invoke a dialog from the hyperlink at the top of function table that
lists the displayed and hidden modules. The Functions list also can be filtered
to display functions for a specific process using the Process drop list.
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GPU Profiling
For GPU application timeline trace profiling:
1. Click on the profiling mode taskbar button.
2. Select Profile >> GPU: Application Timeline Trace from the Profile dropdown menu.
3. Run the program, then let it complete, or terminate it.
An Application Timeline Trace view appears with a timeline of the
program execution. This timeline shows the created OpenCL contexts
and command queues, as well as the relationships between them.
To select a subrange of the timeline, hold down <Ctrl>, and click and
drag on a section of the timeline.
To shift the timeline display left or right, simply click on it and drag.
To zoom in/out, use the mouse wheel or the +/- keys. Selecting a small
subrange lets you zoom in to see details about each event.
For additional information, hover over an event; this displays a pop-up.
The following screenshot is an example of a COPY_BUFFER_TO_IMAGE data
transfer event at 7752.980 ms on the timeline. The pop-up provides detailed
timing data.
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Summary Tab

The Summary tab provides several options for viewing profiling data: API,
context, kernel, top 10 data transfer, top 10 kernel, warnings/errors.
The following screenshot shows an example of a Top 10 Kernel Summary.

The Warning(s)/Error(s) summary also includes a helpful list of best practice
recommendations to improve program performance. The following example
indicates issues with blocking write calls and small global work size.
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Performance Counters View

The Performance Counters view in a GPU Performance Counters profile provides
kernel performance details, including global work size and time. This mode
collects performance counters from the GPU or APU for each kernel dispatched
to the device. It also displays statistics from the shader compiler for each kernel
dispatched. The performance counters and statistics can be used to discover
kernel bottlenecks.
To display a Code viewer with kernel code:
1. Click on a kernel name (Method) in the Performance Counters view.

A pull-down bar at the top of the window under the Code Viewer tab (see
following screenshot) lets you select OpenCL source (CL), intermediate language
(IL), or instruction set architecture (ISA) code.
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CodeXL Explorer Tree

The Explorer view lets you switch between profiling sessions. This view lists all
profiling sessions for the current project.

To display a session’s data, double-click on it. To rename or delete it, right-click
on it.
To import profiling data, right-click or drag/drop a session data file to the
Explorer.
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Power Profiling
Power Profiling mode allows monitoring the power consumption of supported
AMD APUs in real-time. Additional attributes can also be monitored: GPU and
CPU frequencies, APU thermal trend and CPU Cores P-State.
The currently supported APUs are Kaveri, Mullins and Temash. Future APUs will
be supported as well.
Switching to Power Profiling mode

In the Profile Mode drop-down list, choose Power Profiling.

Starting a new Power Profiling session

After switching to Power Profiling mode, double click New Power Session… in
the CodeXL Explorer tree.

Please note that if your hardware does not support Power Profiling, you will not
be able to start the session.
After double clicking on New Power Session… in the CodeXL Explorer tree, an
empty Power Profiling session window will be opened.
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Clicking the Start button will start the session with the current configuration.
We will now see how to change a Power Profiling session’s configurations.
Setting the Sampling Interval

To configure the sampling interval (the time period which will pass between
every two consecutive samples of the active counters), click on Profile->Profile
Settings -> Power Profile:

Please note that the current minimum sampling interval is 100 milliseconds.
Click OK to apply your changes.
Stopping a Power Profiling session

To stop a running Power Profiling session, click on the Stop button

.

Power Profiling Real-Time Values

Throughout the Power Profiling session, the collected data will be streaming in
real-time to the graphs. There are two tabs that present data: Timeline View and
Summary View.

29
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Power Profiling Timeline View

The Power Profiler Timeline View displays the measured values of the activated
counters throughout the session. The horizontal axis of all charts represents the
time that has passed since the beginning of the session. During profiling sessions,
all of the charts in the Timeline View are being updated in real-time with the
measured values which are streaming in. The uppermost ribbon (titled “Total
APU Power”) displays the overall power consumption of the APU throughout the
session.
The top chart has an adjustable range slider that controls the display of all the
other timeline charts. By performing such actions as dragging the slider
sideways, extending or retracting it, you set the scope of attention and the focus
of the timeline charts. Each of the charts below displays only the data that was
collected in the time range corresponding to the slider’s position and length.
That is, the data in all timeline charts, except for the Total APU Power chart itself,
is dictated by the time range which is selected by the Total APU Power chart’s
range slider.
Below the Total APU Power ribbon, you will find additional ribbons containing
more graphs, according to the set of activated counters: A Power chart which
displays the power consumed by specific APU components (such as CPU cores or
integrated GPU), a Frequency chart which displays the frequency of the selected
components, a Temperature chart which displays the thermal trend of the
selected components, and a CPU State chart which displays the CPU core states.
The APU Power graph is always displayed, since the Total APU Power counter is
activated by default and cannot be deactivated. The other charts (frequency,
temperature and CPU core state) are optional, and will only be displayed if the
relevant counters were activated.
To the right side of each chart you will find a legend that displays the measured
values at a specific point in time. To change the point in time for which the values
30
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are displayed, reposition the mouse cursor horizontally on one of the graphs. The
list of counters in the legends is customizable, and specific counters can be
removed/added between profile sessions.
Power Profiling Summary View

The Power Profiler Summary View displays an analysis of the values measured
throughout the session. Similarly to the Timeline View, this view is updated in
real-time when power profiling sessions are running.
At the upper-left side of the summary view, you can see the session duration
which is the amount of time that the profiling session was in progress.
The uppermost chart (titled “Power”) shows the Total APU Power/Energy
consumption. This chart has two modes: Cumulative and Average. The
Cumulative mode displays the cumulative energy consumed by the APU
components, measured in Joules. The Average mode displays the average power
consumption of the APU components, measured in Watts. For each of these two
modes, the Total APU Power Consumption value at the top of the summary view
represents the value consumed by the whole APU.
In order to switch between the Cumulative and Average modes, click on the label
and select the desired mode:

31

© 2014 Advanced Micro Devices, Inc.

Getting Started with CodeXL
If CPU or GPU frequency counters were activated for the session, you will find
additional histogram graphs below the Power graph in the Summary View:
o CPU Frequency Graph
This stacked histograms graph displays for each CPU core how much time it
spent at each frequencies range.
o GPU Frequency Graph
This graph displays how much time the GPU spent at each frequencies range.
Configuring Power Profiler Sessions

For further configuration options of the Power Profiler such as selecting which
counters will be sampled and launching an application when the session begins,
see the CodeXL User Guide by selecting from the menu bar Help -> View Help.

Static Kernel Analysis
Analysis mode provides compilation and analysis information for OpenCL
kernels targeting various AMD GPUs. This is an offline tool which means that you
can get the compilation and analysis results regardless of the actual GPU type
you have installed in your computer. The analysis provides accurate kernel
performance estimates and lets you view kernel compilation results and
assembly.
Switching to Analysis mode

Option 1:
Click on the Analyze Mode button in the CodeXL Mode toolbar.

Option 2:
Click Analyze in the main menu.
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Once you switch to Analysis mode, you can create a new project, open a
previously saved project or load the Teapot sample.
Creating a new project for Kernel Analysis

Click on the “Create New Project” link. The following CodeXL Project Settings
dialog will appear:

Choose the executable file you want to work on. Now, in order to begin working,
you simply need to add the cl file you want to compile and analyze.
Note: The chosen executable has no part in Analysis mode. Choosing an
executable file is required so that the other modes can be used too, but if you
plan to use Analysis mode only, you can select any executable you want as it will
not be used.
33
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Adding OpenCL files to an existing project

Option 1:
Double click on the plus sign and add your file:

Option 2:
From the main toolbar, select Add existing OpenCL Files to Project….

Option 3:
Right click on the project name, and select Add OpenCL File.
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Note: You can add as many OpenCL files to a single project as you need. The
OpenCL files do not necessarily need to be relevant to the executable you chose
for your project.
Analyze Mode Options

To open the Analyze Mode options tab in the CodeXL Options dialog, use the
Analyze Options… toolbar button.

The Analyze tab of the CodeXL Options dialog appears:
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Select target devices
The ASICs table contains a list of devices by series.
Use the checkboxes to select or unselect an entire series, or click the small
triangle on the left to expand a tree node and expose specific families of target
devices.
Note: AMD ASIC’s are grouped now by generation name. ie: “Graphics IP v7” etc.
which is the correct way to identify device type and characteristics.
Changing the default global/local workgroup dimensions
For each Kernel, you can set the Global and local work size. For a 3D kernel X, Y,
Z must be supplied. For a 2D kernel, Z must be defined as 0 or 1, and for a 1D
kernel both Y and Z must be defined as 0 or 1.
Set the number of the loop iterations
36
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This option is used during kernel analysis. This value will be used by the offline
analysis when detecting a loop in the kernel. The analysis will consider all the
instructions in loop blocks to be executed the number of times defined in the
options’ Loop Iterations field.
Build Options- Defining kernel compilation options

In the Static Analyze toolbar, there is a space where you can define specific
kernel OpenCL build options:

Note: The display of this toolbar is dynamic; you can set it from the right-click
menu in the main CodeXL frame:

The Build Options box is a place to set compiler build flags such as –x clc++ or
–o3. Any compiler build flag can be placed in this box.
37
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OpenCL Build Options Dialog
This dialog will help you choose the correct OpenCL build options for you and
hopefully will prevent you from making spelling mistakes while typing the
options manually.
To open the OpenCL Build Options dialog, press the
Button. You can
browse between the ‘General & Optimization’ tab and the ‘Other’ tab to view all
the available options. Once you choose an option, the option text will appear in
the text box below marked as ‘OpenCL Build Command Line’. This string will also
appear in the menu bar after you click the OK button.
Typing the command line in the text box will also mark the corresponding check
boxes in the dialog.

Example of using build options
For building the tpAdvectFieldScalar.cl kernel from CodeXL’s AMDTTeaPot
sample project, enter the following options:
-D GRID_NUM_CELLS_X=64 -D GRID_NUM_CELLS_Y=64 -D GRID_NUM_CELLS_Z=64
-D GRID_INV_SPACING=1.000000f -D GRID_SPACING=1.000000f -D
GRID_SHIFT_X=6 -D GRID_SHIFT_Y=6 -D GRID_SHIFT_Z=6 -D
GRID_STRIDE_Y=64 -D GRID_STRIDE_SHIFT_Y=6 -D GRID_STRIDE_Z=4096 -D
GRID_STRIDE_SHIFT_Z=12 -I path_to_example_src

On windows, path_to_example_src should be:
C:\Program Files\AMD\AMD CodeXL\Examples\Teapot\res

On Linux, path_to_example_src should be:
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/opt/AMD/CodeXL/bin/examples/Teapot/AMDTTeaPotLib/AMDTTeaPotLib/

Adding the option ‘-h’ will dump the list of OpenCL compiler available options in
the output tab.

Building and Analyzing an OpenCL File

Build and Analyze
The Build and Analyze command builds an OpenCL file for the designated target
devices, produces ISA and IL files for each device, and displays statistics for each
kernel. The compiler output (such as warnings and errors) is shown in the
output tab. This command also performs offline analysis that details how many
instructions from each instruction family the kernel is using. Analysis is available
for ASICs from the Southern Islands generation and higher generations.
To Build and Analyze an OpenCL file, do one of the following:
•
•
•

Press F7
From the menu bar, click Analyze >> Build and Analyze
Right-click the designated OpenCL file in the explorer tree, and select
“Build and Analyze kernel”

Build
The Build command builds an OpenCL file for the designated target devices,
produces ISA and IL files for each device, and displays statistics for each kernel.
The compiler output (such as warnings and errors) is shown in the output tab.
To Build and Analyze an OpenCL file, do one of the following:
•
•
•

Press CTRL + F7
From the menu bar, click Analyze >> Build
Right-click the designated OpenCL file in the explorer tree, and select
“Build”

Output Tab

The compilation output appears in the Output tab. The example below shows
successful builds (no warnings or errors) for 24 of 24 devices. If errors occur, the
output will display the error and the line in which the error occurred.
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Overview Tab

In the Overview tab you can find the OpenCL file name and location, the kernels
list, and Ethe mulation dimensions as given in the Analyze Options tab.
The initial values used in the Emulation dimensions are defined in the Analyze
options. They can be changed in the overview tab before the “Build & Analyze
Command” is executed.

Statistics Tab

The Statistics tab gives detailed statistics for the selected kernel for each target
device. To open the Statistics tab, expand the desired kernel in the project tree,
and double-click the Statistics node:
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The Analysis Tab

The Analysis output tab shows the analysis for the selected kernel based on a
detailed emulation of the kernel execution on the target device.
To open the Analysis tab, expand the desired kernel in the project tree and
double click the Analysis node:

Note: Analysis will be generated only for Southern Islands ASIC generation and
up.
The information displayed in the Analysis results tab is sorted according to the
ASIC family. For each device in the ASIC family, there are 3 columns: True, False,
Both. The control flows for these options are calculated as follows:
When kernel code which contains loops and branches is being executed, there
are 3 options:
-

All waves hitting the branch statement will resolve to true - hence jump to
the designated label.
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-

All waves hitting the branch statement will resolve to false - hence
perform the next statements.
Some waves hitting the branch statement will resolve to false - perform
both the statements. It is enough that some waves will fall into the ‘else’
statement to stall the GPU.

Viewing compilation output: IL and ISA

To view the compilation output, double-click the node of the desired ASIC in the
explorer tree. This action will open a tab containing the source code, the IL, and
the ISA:
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Known Issues
For a list of known CodeXL issues, review the release notes on the CodeXL web
page and the AMD Developer Tools CodeXL forum:
devgurus.amd.com/community/codexl

Support
AMD general developer support page:
http://developer.amd.com/support/
Tools & SDKs section in AMD Developer Tools website:
http://developer.amd.com/tools-and-sdks/
OpenCL Zone in AMD Developer Tools website:
http://developer.amd.com/tools-and-sdks/opencl-zone/
AMD Accelerated Parallel Processing OpenCL Programming Guide:
http://developer.amd.com/wordpress/media/2013/07/AMD_Accelerated_Paral
lel_Processing_OpenCL_Programming_Guide-rev-2.7.pdf
For GPU development issues relating to other AMD tools, see the AMD GPU
Developer Tools Forum:
devgurus.amd.com/community/gpu_developer_tools
To report a specific problem or request help with AMD CodeXL, visit the CodeXL
Forum at:
devgurus.amd.com/community/codexl
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